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Environmental Considerations
This section provides information about the environmental impact of the product.

Product End-of-Life
Handling

Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and
use of natural resources. The equipment may contain substances that could be
harmful to the environment or human health if improperly handled at the product’s
end of life. To avoid release of such substances into the environment and to
reduce the use of natural resources, we encourage you to recycle this product in
an appropriate system that will ensure that most of the materials are reused or
recycled appropriately.

This symbol indicates that this product complies with the applicable European
Union requirements according to Directives 2002/96/EC and 2006/66/EC
on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Support/Service section of the
Tektronix Web site (www.tektronix.com).

Restriction of Hazardous
Substances

This product is classified as Monitoring and Control equipment, and is outside the
scope of the 2002/95/EC RoHS Directive.

AFG3000 Series Quick Start User Manual v



Environmental Considerations

vi AFG3000 Series Quick Start User Manual



Preface
This manual describes the installation and operation of Tektronix AFG3000 Series
Arbitrary Function Generators along with basic operations and concepts. The
following instruments are supported by this manual:

Table i: Supported products

AFG3011 AFG3021B AFG3011C

AFG3101 AFG3022B AFG3021C

AFG3102 AFG3022C

AFG3251 AFG3051C

AFG3252 AFG3052C

AFG3101C

AFG3102C

AFG3251C

AFG3252C

Where to find more information
The following table lists related documentation available for your instrument.
The documentation is available on the Document CD and on the Tektronix Web
site (www.tektronix.com/downloads).

Item Purpose Location

Safety and
Compliance
Instructions

Safety, compliance,
and basic power
information

Quick Start User
Manual

Unpacking,
Installation, Tutorials,
Operation, and
Overviews

Built-in Help UI Help and Operation

Programmer
Manual

Menu Structures,
User Interface,
and Programming
Information

Service Manual Self-service and
Performance test
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Item Purpose Location

Technical
Reference

Specifications
and performance
verification
procedures

ArbExpress
Software CD

Waveform creation

Import waveforms
from oscilloscope or
PC

NOTE. Please see the printed Safety and Compliance Instructions that were
shipped with your instrument for general safety summary, EMC compliance, and
safety compliance information.

Conventions Used in this Manual
The following icons are used throughout this manual.

Front panel power Connect power Network USB

The soft keys along the right side of the display are called bezel buttons in this
manual. In other documents, they may also be called option buttons or side-menu
buttons.
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General features
Each AFG3000 Series Arbitrary Function Generators offers the functionality of
three generators in one:

10 MHz to 240 MHz Function Generator

5 MHz to 120 MHz Pulse Generator

14 bits Arbitrary Waveform Generator

The following tables describe some of the general features of your instrument. An
“X” means the feature is included with the model.

Table 1: General features for regular and B models

Feature AFG3011
AFG3021B/
AFG3022B AFG3101/ AFG3102 AFG3251/ AFG3252

Channel 1 1/2 1/2 1/2

Sine 10 MHz 25 MHz 100 MHz 240 MHz

Pulse 5 MHz 12.5 MHz 50 MHz 120 MHz

Memory 2 to 131,072 2 to 131,072 2 to 16,384 >16,384 to
131,072

2 to 16,384 >16,384 to
131,072

Sampling Rate 250 MS/s 250 MS/s 1 GS/s 250 MS/s 2 GS/s 250 MS/s

Amplitude 20 Vp-p 10 Vp-p 10 Vp-p 5 Vp-p

Display Color Monochrome/
Color

Color Color

Interface USB, LAN,
GPIB

USB, LAN,
GPIB

USB, LAN, GPIB USB, LAN, GPIB

Ground
isolation

X X X X

Synchronous
operation

X X X X

Context-sensitive
Help system

X X X X

ArbExpress®
Software

X X X X
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Table 2: General features for C models

Feature AFG3011C
AFG3021C/
AFG3022C

AFG3051C/
AFG3052C

AFG3101C /
AFG3102C

AFG3251C /
AFG3252C

Channel 1 1 / 2 1 / 2 1 / 2 1 / 2

Sine 10 MHz 25 MHz 50 MHz 100 MHz 240 MHz

Pulse 5 MHz 25 MHz 40 MHz 50 MHz 120 MHz

Memory 2 to
131,072

2 to 131,072 2 to 131,072 2 to
16,384

>16,384
to
131,072

2 to
16,384

>16,384
to
131,072

Sampling
Rate

250 MS/s 250 MS/s 1 GS/s 1 GS/s 250 MS/s 2 GS/s 250 MS/s

Amplitude 20 Vp-p 10 Vp-p 10 Vp-p 10 Vp-p 5 Vp-p

Display Color Color Color Color Color

Interface USB, LAN,
GPIB

USB, LAN, GPIB USB, LAN, GPIB USB, LAN, GPIB USB, LAN, GPIB

Ground
isolation

X X X X X

Synchronous
operation

X X X X X

Context-sensitive
Help
system

X X X X X

ArbExpress®
Software

X X X X X
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Before Installation
Inspect the instrument carton for external damage. If the carton is damaged,
notify the carrier.

Remove the instrument from its package and check that it has not been damaged in
transit. Verify that the carton contains the instrument and its standard accessories.

Operating Requirements
Environmental

1. Place the instrument on a cart or bench, observing
clearance requirements:

Sides: 50 mm (2 in)

Rear: 50 mm (2 in)

2. Before operating, ensure that the ambient
temperature is between 0 °C to +50 °C (+32 °F
to +122 °F).

CAUTION. To ensure proper cooling, keep both sides of the instrument clear of
obstructions.

Power Supply
Requirements

WARNING. To reduce the risk of fire and shock, ensure that the mains supply
voltage fluctuations do not exceed 10% of the operating voltage range.

Requirement AFG3000 series / AFG3000B series / AFG3000C series

Source Voltage and Frequency 100 V to 240 V, 47 Hz to 63 Hz; or 115 V, 360 Hz to 440 Hz

Power Consumption Less than 120 W
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Standard Accessories
Unpack the instrument and check that you received all items listed as Standard
Accessories. Check the Tektronix Web site (www.tektronix.com) for the most
current information.

Table 3: Standard accessories

Description Tektronix part number

AFG3000 Series Arbitrary Function Generators Safety and Compliance Instructions 071-3244-xx

AFG3000 Series Documentation CD containing the following PDF documents: 063-3828-xx

AFG3000 Series Arbitrary Function Generators Quick Start
User Manual

077-0957-xx (English)

077-0958-xx (French)

077-0967-xx (Italian)

077-0959-xx (German) 1

077-0960-xx (Russian) 1

077-0961-xx (Japanese) 1

077-0962-xx (Portuguese) 1

077-0963-xx (Simplified Chinese) 1

077-0964-xx (Traditional Chinese) 1

077-0965-xx (Korean) 1

077-0966-xx (Spanish)

AFG3000 Series Arbitrary Function Generators Programmer
Manual

077-0743-xx

AFG3000 Series Arbitrary Function Generators Service
Manual

077-0744-xx

AFG3000 Series Arbitrary Function Generators Specifications
and Performance Verification Manual

077-0691-XX

ArbExpress (Application Software for Tektronix Arbitrary Function Generators) Software CD 063-3763-xx

Power cord

North America (Option A0) 161-0066-00

Universal Euro (Option A1) 161-0066-09

United Kingdom (Option A2) 161-0066-10

Australia (Option A3) 161-0066-13

Switzerland (Option A5) 161-0154-00

Japan (Option A6) 161-0298-00

China (Option A10) 161-0304-00

India (Option A11) 161-0400-00
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Table 3: Standard accessories (cont.)

Description Tektronix part number

Brazil (A12) 161-0357-00

No power cord or AC adapter (Option A99) - - -

1 These manuals contain a language overlay for the front panel controls.

Optional accessories
The following optional accessories are recommended for your instrument:

Table 4: Optional accessories

Description Tektronix part number

50 Ω BNC cable, double-shielded, 91 cm (36 in) 012-0482-XX

50 Ω BNC cable, double-shielded, 250 cm (98 in) 012-1256-XX

GPIB interface cable, double-shielded, 200 cm (79 in) 012-0991-XX

Rackmount kit RM3100

Fuse adapter (BNC-P to BNC-R) 013-0345-XX

0.125 fuse set (contains three fuses) 159-0454-XX

NOTE. To ensure the EMC compliance listed in the Specifications, connect only
high quality shielded cables to this instrument. High quality shielded cables
typically are braid and foil types that have low impedance connection to shielded
connectors at both ends.

Cleaning
Inspect the instrument as often as operating conditions require. To clean the
exterior surface, perform the following steps:

1. Remove loose dust on the outside of the instrument with a lint-free cloth. Use
care to avoid scratching the display.

2. Use a soft cloth dampened with water to clean the instrument. Use an aqueous
solution of 75% isopropyl alcohol for more efficient cleaning.

CAUTION. To avoid damage to the surface of the instrument, do not use any
abrasive or chemical cleaning agents.

CAUTION. Avoid getting moisture inside the unit during external cleaning. Use
only enough cleaning solution to dampen the cloth or swab.
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Power the instrument on and off
The following procedures show you how to apply power to the instrument and
turn it on and off.

Power on

1. Insert the AC power cord into the power receptacle
on the rear panel.

2. Push the front-panel power button to power on the
instrument.

Wait until the front panel display shows that the
instrument has passed all power-on self tests before
using the instrument.

Power off

1. Push the front-panel power button to power off the
instrument.
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Change instrument settings at power-on
The default settings are restored when you power on the instrument. You can
change the power-on settings to the last powered-off settings from the Utility
menu using the following procedure.

NOTE. You can restore the instrument to its default settings at any time by pushing
the front-panel Default button.

1. Push the front-panel Utility
button.

2. Push the System bezel button.

3. Push the Power On bezel button
to select from the following the
power on settings.

Default restores the default
settings when the instrument
is powered on.

Last restores the same
settings as when the
instrument was last powered
off.
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Erase instrument setups and waveforms from memory
You can also erase all instrument setups and waveforms from the instrument
internal memory using the following procedure.

NOTE. You can restore the instrument to its default settings at any time without
erasing memory by pushing the front-panel Default button.

1. Push the front-panel Utility
button.

2. Push the System bezel button.

3. Push the Secure bezel button.

4. Push the OK bezel button to
erase all setups and waveforms
stored in internal memory, or
push the Cancel bezel button to
cancel the operation.

Perform instrument self test and self calibration
The instrument performs a limited set of hardware tests at power-on. You can
also perform the following manual diagnostics and/or self calibration using the
Utility menu:

Diagnostics (Self test): Perform the self test to verify that your instrument
is operating correctly.

Calibration (Self calibration): The self calibration mainly checks DC accuracy
using the internal calibration routines.

NOTE. If you need to verify that the instrument meets the warranted specifications,
do the complete set of performance verification procedures provided in the
Specifications and Performance Verification manual.
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1. Push the front-panel Utility
button.

2. Push the -more- bezel
button.

3. Push the
Diagnostics/Calibration
bezel button.

4. To execute the instrument
diagnostics, push the
Execute Diagnostics
bezel button.

To execute self calibration,
push the Execute
Calibration bezel button.

5. If Diagnostics completes
without any errors, the
message “PASSED” is
displayed.

CAUTION. Do not power off the instrument while executing self calibration. If the
power is turned off during self calibration, data stored in the internal memory
may be lost.

Quick Tips Before executing self calibration, ensure that the ambient temperature is
between +20 °C and +30 °C (+68 °F to +86 °F). Allow a 20 minute warm-up
period before executing self calibration.

Disconnect all the cables from the instrument when you perform self test or
self calibration.

Perform self calibration at least once a year to maintain DC accuracy. It is
recommended that the self calibration should be performed along with a
periodic check.
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Select a local language
You can select the language you want displayed on the instrument screen.

1. Push the front-panel Utility
button.

2. Push the Language bezel button.

3. Select the desired language.

You can select from English,
French, German, Japanese,
Korean, Simple Chinese,
Traditional Chinese, and
Russian.

Quick Tips When you power on the instrument for the first time, English is selected by
default. After you select a desired language, all the bezel menus, pop-up
messages, and built-in help are displayed in the specified language. The main
display area is not translated.

Use the front panel overlay that corresponds to each local language.

10 AFG3000 Series Quick Start User Manual



Getting started

Protect your instrument from misuse

Check input and output
connectors

1. Locate the output
connectors on the
front panel. The
image shown here
shows the outputs.

2. Locate the input
connector on the
front panel. Some
instrument models
have more than one
input.

NOTE. When connecting a cable, be sure to distinguish the input connector from
the output connectors to avoid making the wrong connection.

The instrument input and output connectors are floating inputs/outputs.

WARNING. To avoid personal injury due to electric shock, do not apply voltages
in excess of 42 Vpk to any BNC connector ground or to the chassis ground.

CAUTION. Do not short output pins or apply external voltages to Output
connectors. The instrument may be damaged.

CAUTION. Do not apply excessive inputs over +5 V to Trigger Input connector.
The instrument may be damaged.
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Use fuse adapter The instrument will be damaged if a large DC or AC voltage is applied to the
output or input connectors. To protect the output circuits, a fuse adapter is
provided as an optional accessory. When the instrument is used by students or
other inexperienced users, always attach the fuse adapter to the output connectors
to avoid damage. (See page 5, Optional accessories.)

Figure 1: Fuse and fuse adapter

1. Fuse adapter

2. Fuse
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Floating ground
Since the common (input and output channel common) of the arbitrary function
generator is electrically isolated from the chassis ground (the instrument chassis
and ground line of the AC connector), you can make a floating connection
between the instrument and other equipment.

All the signal output connectors are connected to the common ground, and the
remote interface connector is connected to the chassis ground.

WARNING. To prevent electrical shock, use this product so that the sum of the
floating voltage and the output voltage of the instrument does not exceed 42 Vpk.
Do not touch the center of the BNC while the equipment is in use.

CAUTION. The maximum rated voltage between the chassis ground and common
ground is 42 Vp-p (DC + peak AC). When the potential voltage between the
chassis ground and common ground goes over 42 Vp-p, the internal protective
circuit will be activated to protect the circuits. However, higher voltage may cause
the internal circuits in the instrument to be damaged.

When a potential voltage exists between the chassis ground and common ground,
a short circuit from output to ground causes the instrument internal fuse to open
and the output is stopped. If the fuse opens, you need to contact your local
Tektronix Service Support.

When a potential voltage exists between the common ground and chassis ground,
short-circuiting between them may lead to excessive current flow and the internal
or external circuits may be damaged.

AFG3000 Series Quick Start User Manual 13



Getting started

Protect your DUT
Use care when you connect the instrument Channel Output to your DUT (device
under test). To avoid damage to your DUT, the following preventive measures are
provided. Follow these steps to set the limit values for high level and low level.

1. Push the front-panel Top
Menu button. The Output
Menu is displayed at the
bottom of the bezel menu.
Select Output Menu.

2. In this example, High
Limit is set to 5.000 V,
and Low Limit is set to
-5.000 V.

3. Push the Limit bezel
button.

4. Select High Limit. Use
numeric keys or the
general purpose knob to
enter a value.

Enter 50 mV for High
Limit, and -50 mV for Low
Limit.

5. Push the front-panel
Sine button to display
the waveform parameter.
Confirm that High and
Low voltage levels were
changed.

You cannot enter any
values greater than
50 mV for High level.

NOTE. When you set limit values using Output Menu, a level indicator is
displayed at left end of graph area.
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Update your instrument firmware
You can use the front-panel USB memory connector to update your instrument
firmware.

CAUTION. Updating your instrument firmware is a sensitive operation which
may damage your instrument if you do not follow all instructions carefully. To
prevent damage to the instrument, do not remove the USB memory or power off
the instrument during the update process.

NOTE. The screen images of the following procedure are provided as an example.
The actual screen display may be different depending on your instrument
configuration.

1. Push the front-panel Utility
button to display the Utility
menu.

Version information is displayed
on the screen. Confirm the
firmware version of your
instrument.

2. Visit www.tektronix.com, and
check if Tektronix offers a newer
firmware version. Download
the compressed zip file with the
most current firmware to your
PC.

Unzip the downloaded file and
copy the file to the root directory
of your USB memory device.

3. Insert the USB memory device
into the front-panel USB
connector and check that you
have saved the file to the root
directory of the USB memory
device.
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4. Push the -more- bezel button
twice in the Utility menu.

5. The third page of the Utility menu
is displayed. Select Firmware
Update.

NOTE. If the USB memory is not
inserted, the Firmware Update bezel
button is disabled.

NOTE. If Access Protection is on,
the Firmware Update bezel button is
disabled. You can read more about
access protection. (See page 81.)
6. Select the downloaded firmware

file by rotating the general
purpose knob, and then push
the Execute bezel button.

7. Follow the on-screen
instructions.

8. Check that the clock symbol
at the top right of the screen
indicates the update process is
in progress.

CAUTION. A firmware update
usually takes approximately two
minutes. Do not remove the USB
memory during the update process.

CAUTION. If you accidentally
removed the USB memory during the
update process, do not power off the
instrument. Repeat the installation
process from step 3.
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9. Wait until the instrument displays
"Operation completed".

10. Push OK.

CAUTION. If “Operation completed”
is not displayed, do not power off the
instrument. Repeat the installation
process from step 2 using a different
type of USB memory device.

11. Remove the USB memory from
the front-panel USB connector.

12. Power the instrument off and
then back on.

13. Push the front-panel Utility
button to display the Utility
menu.

Confirm that the firmware has
been updated.

NOTE. You can protect access to firmware update using the Security menu.

Connect to a network
The AFG3000 series arbitrary function generator communication interface allows
you to communicate with or remotely control your instrument. You can use a
USB, Ethernet, or GPIB interface.

USB Interface The USB interface requires no front panel or bezel menu operations to set up. Use
a USB cable to connect your instrument to a PC.

Ethernet Setup To connect your instrument to a network, you must first obtain information from
your network administrator. The procedure for entering the Ethernet network
parameters depends on your network configuration. If your network supports
DHCP (Dynamic Host Configuration Protocol), follow these steps:
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1. Connect a LAN cable to
the LAN port on the rear
panel.

2. Push the front-panel
Utility button.

3. Push the I/O Interface >
Ethernet bezel buttons.

4. The Ethernet Network
Settings menu is
displayed.

By selecting the DHCP
On, the instrument can
set its network address
automatically through
DHCP.
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If you cannot establish
communication by setting
DHCP On, you need to set up
an IP Address manually and
a Subnet Mask if necessary.
Follow these steps:

5. Display the Ethernet
Network Settings menu
and select DHCP Off.

6. Push the IP Address
bezel button to enter an
IP address. You need
to contact your network
administrator to get the IP
address to use.

7. Push the Subnet Mask
bezel button to enter a
Subnet Mask. Ask your
network administrator
whether a subnet mask is
required.

8. Push the Default Gateway
bezel button to enter
a gateway address.
Ask your network
administrator for the
gateway address.

GPIB Setup To set the instrument GPIB interface, follow these steps:

1. Connect a GPIB cable to
the rear panel GPIB port.

2. Push the front-panel
Utility button.
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3. Push the I/O Interface >
GPIB bezel buttons.

4. Push the Address bezel
button to assign a unique
address to the instrument.

The GPIB address
defines a unique address
for the instrument. Each
device connected to the
GPIB bus must have a
unique GPIB address.
The GPIB address must
be from 0 to 30.

5. Push the Configuration
bezel button to toggle
the instrument bus
communications on
and off.

Talk/Listen - Select
this mode to remotely
control the instrument
from an external host
computer.

Off Bus - Select this
mode to disconnect
the instrument from
the GPIB bus.
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Quick Tip Refer to the AFG3000 Series Arbitrary Function Generators Programmer
Manual for information on remote control commands.

Equivalent Output Circuits
The following illustrations show the equivalent output circuits for the
AFG3000 series instruments:

1. AFG3011 / 3011C

Output signals do
not exceed ±20 V
when the >50 Ω load
impedance is used.

2. AFG3021B / 3021C /
AFG3022B / 3022C /
3051C / 3052C

Amplitude and offset of
the output signals are
not affected by load
impedance.
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3. AFG3101 / 3101C / 3102
/ 3102C

Output signals do
not exceed ±10 V
when the >50 Ω load
impedance is used.

Voltage over the
maximum level is
clipped.

Amplitude and offset
are affected when
you change the
load impedance.
The maximum and
minimum levels do
not exceed ±10 V,
respectively.

4. AFG3251 / 3251C / 3252
/ 3252C

Output signals do
not exceed ±10 V
when the >50 Ω load
impedance is used.
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The following table shows the output window (maximum and minimum levels)
for sine waveform when you change the load impedance (L). Load impedance
will affect the output window.

L = 50 Ω L = High Z

AFG3011 / 3011C

Maximum level
Minimum level
(Maximum
amplitude)

10 V -10 V (20 Vp-p) 20 V -20 V (40 Vp-p)

AFG3021B / 3021C / 3022B / 3022C / 3051C / 3052C

Maximum level
Minimum level
(Maximum
amplitude)

5 V -5 V (10 Vp-p) 10 V -10 V (20 Vp-p)

AFG3101 / 3101C / 3102 / 3102C

Maximum level
Minimum level
(Maximum
amplitude)

10 V -10 V (10 Vp-p) 10 V -10 V (20 Vp-p)

AFG3251 / 3251C / 3252 / 3252C

Maximum level
Minimum level
(Maximum
amplitude)

5 V -5 V (5 Vp-p) 10 V -10 V (10 Vp-p)

Overheat Protection (AFG3011 / 3011C Only)
The instrument internal temperature is monitored in the AFG3011 and AFG3011C.
A warning message will appear if the internal temperature reaches a threshold
level, and signal output will automatically turn off. If the warning message
appears, check for the following conditions:

The ambient temperature requirement is being met.

The required cooling clearance is being met.

The instrument fan is working properly.
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Instrument interface, front panel, and rear panel

Front panel overview
The front panel is divided into easy-to-use functional areas. This section provides
you with a quick overview of the front panel controls and the screen interface.
The following figure shows the front panel of the dual-channel model.

1. Bezel menu buttons

2. Top menu button

3. Function buttons

4. Shortcut buttons

5. Numeric keypad

6. Triggered LED is lit when the instrument receives an internal or external
trigger

7. Trigger input connector

8. Trigger output connector

9. Menu buttons

10. CH 1 and CH 2 output connectors

11. Return to previous menu button

12. View button
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13. USB connector

14. Power on/off switch

Lock or unlock the front
panel controls

If you need to lock the front panel controls, use the following remote command:

SYSTem:KLOCk[:STATe]

To unlock the front panel without using a remote command, push the front-panel
Cancel button twice.

Parts of the screen interface

Bezel menu. When you push a front panel button, the instrument displays the
corresponding menu on the right side of the screen. The menu shows the options
that are available when you push the unlabeled bezel buttons directly to the right
of the screen. (Some documentation may also refer to the bezel buttons as option
buttons, side-menu buttons, or soft keys.)

Main display area and View tab. Pushing the front-panel View button toggles
through the view format of the main display area. The view tabs correspond with
the current view format. The instrument can display three different screen formats.

Output status. If the output is set to disable, Output Off message is displayed in
this area. When you push the front panel channel output button to enable the
output, the message will disappear.

Message display area. A message that monitors hardware status such as clock or
trigger is displayed in this area.
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Level meter. Amplitude level is displayed. The following figure describes the
level meter.

1. Shows maximum
amplitude level of your
instrument.

2. Shows the range of high
limit and low limit set by
the user.

3. Shows the amplitude level
that is currently selected.

View button
The instrument provides the following three screen view formats:

Waveform parameter and graph display

Graph comparison

Waveform parameter comparison

26 AFG3000 Series Quick Start User Manual



Instrument interface, front panel, and rear panel

1. To change the screen
display format, push the
front-panel View button.

2. The first format provides
the single channel
waveform parameters
and graph display.

(Dual-channel model
only): You can
toggle the CH1 and
CH2 information by
pushing the channel
select button.

When you push the View
button once, the view
format is changed to
the graph comparison
format.

Push the View button
again to display the
third format. This view
provides the channel
parameter comparison.

Quick Tips If the instrument is currently in the Save, Recall, Utility, Help, or Output
menu, pushing the View button will have no effect.

When the instrument is in the Edit menu, pushing the View button will toggle
between Edit text and graphical views. This is the only function of the
single-channel model view button.
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Shortcut buttons
Shortcut buttons are provided for experienced users. The shortcut buttons allow
you to select a setup parameter and enter a numeric value using the front panel
controls. By using the shortcut buttons, you can select a waveform parameter
without using any bezel menu selection.

1. Shortcut buttons are located
below the Run Mode buttons on
the front panel.

In this example, use pulse
waveform.

2. If you push the Amplitude/High
shortcut button once, Amplitude
becomes active.

3. If you push the Amplitude/High
shortcut button again, High Level
becomes active.

You can also set parameters for
Frequency/Period, Offset/Low,
Duty/Width, or Leading/Trailing
in the same way.

Quick Tips If you push the Phase | Delay shortcut button, Delay becomes active. Pushing
Phase | Delay again will have no effect, because there is no phase parameter
in the pulse parameter menu.

The Duty/Width and Leading/Trailing shortcut buttons are functional only
when the instrument is in the pulse parameter menu.
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Default Setup
When you want to restore the instrument settings to the default values, use the
front-panel Default button.

1. Push the front-panel Default
button.

2. A confirmation pop-up message
appears on the screen.

Push OK to recall the default
settings.

Push Cancel to cancel the recall.

3. If you select OK, the instrument
displays a 1 MHz frequency,
1 Vp-p amplitude sine waveform
as the default setup.

Quick Tips The AFG3000 Series Arbitrary Function Generators Programmer Manual
describes the default setup settings in detail. This manual is available on the
accompanying Documentation CD or at www.tektronix.com/downloads.

The front-panel Default button does not reset the following settings:

Language option

Power-on settings

System related settings (display contrast, screen saver, click tone, and
beeper)

Saved setups and arbitrary waveform data

Calibration data
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GPIB and Ethernet setups

Access protection

Select Waveform
The instrument can provide 12 standard waveforms (Sine, Square, Ramp,
Pulse, Sin(x)/x, Noise, DC, Gaussian, Lorentz, Exponential Rise, Exponential
Decay, and Haversine). The instrument can also provide user-defined arbitrary
waveforms. You can create, edit, and save your custom waveforms.

You can also create modulated waveforms using the Run Mode Modulation
menus. The following table shows the combination of modulation type and the
shape of the output waveform.
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The following matrix shows which waveforms are allowed with each run mode.

Run Mode

Sine, Square, Ramp, Arb, Sin(x)/x,
Gaussian, Lorentz, Exponential Rise,
Exponential Decay, Haversine Pulse

Noise,
DC

Continuous √ √ √

Modulation

AM √

FM √

PM √

FSK √

PWM √

Sweep √

Burst √ √

NOTE. When the instrument outputs an Arb waveform, Vp-p of instrument setup
indicates the Vp-p value of normalized waveform data.

When the instrument outputs Sin(x)/x, Gaussian, Lorentz, Exponential Rise,
Exponential Decay, or Haversine, Vp-p is defined as twice the value of 0 to peak
value.
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To select an output waveform, follow these steps:

1. To select a continuous
sine waveform, push
the front-panel Sine
button and then push
the Continuous button.

2. You can directly select
one of four standard
waveforms from the
front-panel Function
buttons.

3. To select an arbitrary
waveform, push the
Arb button.

4. To select other
standard waveforms
such as Sin(x)/x,
Noise, DC, or
Gaussian, push the
More... button, and
then push the top
bezel button.

5. These are waveform
examples of Sin(x)/x
and Noise.

6. These are waveform
examples of DC and
Gaussian.
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7. These are waveform
examples of Lorentz
and Haversine.

8. These are waveform
examples of
Exponential Rise and
Exponential Decay.
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Select Run Mode
Push one of the four Run Mode buttons to select the instrument signal output
method.

1. The default
Run Mode is
Continuous.

You can read more about
changing waveform
parameters. (See
page 35.)

2. To select a
modulated
waveform, push the
Modulation button.

You can read more about
modulating waveforms.
(See page 58, Modulate
a Waveform.)
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3. To select a sweep
waveform, push the
Sweep button.

You can read more about
sweeping waveforms.
(See page 55.)

4. To select a burst
waveform, push the
Burst button.

You can read more
about Burst mode. (See
page 54.)

Adjust Waveform Parameters
When you turn on your instrument, the default output signal is a 1 MHz sine
waveform with an amplitude of 1 Vp-p. In the following example, you can change
the frequency and amplitude of the original output signal.

1. Push the front-panel
Default button to display
the default output signal.

2. To change frequency,
push the front-panel
Frequency/Period
shortcut button.
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3. Frequency is now active.
You can change the value
using the keypad and
Units bezel menu, or you
can change the value
with the general purpose
knob.

4. Push the
Frequency/Period
shortcut button again
to toggle the parameter to
Period.

5. Next, change amplitude.
Push the Amplitude/High
shortcut button.

6. Amplitude is now active.
You can change the value
using the keypad and
Units bezel menu, or
you can change the value
using the general purpose
knob.

7. Push the Amplitude/High
shortcut button again to
toggle the parameter to
High Level.

You can change the
values of Phase and
Offset in the same way.

8. To change the amplitude
units, push the -more-
bezel button to display
the second page.

9. Push the Units bezel
button to display units
selection bezel menu. By
default, Vp-p is selected.
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Quick Tip The following conversion table shows the relationship between Vp-p, Vrms,
and dBm.

Vp-p Vrms dBm

20.00 Vp-p 7.07 Vrms +30.00 dBm

10.00 Vp-p 3.54 Vrms +23.98 dBm

2.828 Vp-p 1.00 Vrms +13.01 dBm

2.000 Vp-p 707 mVrms +10.00 dBm

1.414 Vp-p 500 mVrms +6.99 dBm

632 mVp-p 224 mVrms 0.00 dBm

283 mVp-p 100 mVrms -6.99 dBm

200 mVp-p 70.7 mVrms -10.00 dBm

10.0 mVp-p 3.54 mVrms -36.02 dBm

Channel Select (dual-channel model only)
1. Push the front-panel

Channel Select button to
control the screen display.
You can toggle between
the two channels.

NOTE. If you push the Channel Select button while you are in the Utility, Save,
Recall, or Help menu, the screen display returns to the previous view. The
channels do not toggle.
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Output ON/OFF
1. To enable signal output,

push the front-panel
Channel Output On
button. The button is lit
with an LED when it is in
the On state.

You can configure the
signal with the outputs
off. This will allow you
to minimize the chance
of sending a problematic
signal to a DUT.

2. (Dual-channel model
only) You can turn on or
off the signal output for
channel 1 and channel
2 independently.

You can enable one of the
two channels or enable
both of the two channels
at any time.
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Rear Panel
The following illustration shows the rear panel connectors for the instrument.

1. ADD INPUT: The ADD INPUT connector is provided with AFG3101 /
3101C / 3102 / 3102C / 3251 / 3252 / 3252C. This connector lets you add an
external signal to the CH1 output signal.

2. EXT MODULATION INPUT (CH1 and CH2): The CH1 INPUT and CH2
INPUT are independent. The signal input level of these connectors controls
modulation parameters.

3. EXT REF INPUT: This is a BNC connector for the external reference input.
When you want to synchronize multiple AFG3000 series arbitrary function
generators, or synchronize your arbitrary function generator and another
instrument, use the external reference input connector.

4. EXT REF OUTPUT: This is a BNC connector for the external reference
output. When you want to synchronize multiple AFG3000 series arbitrary
function generators, or synchronize your arbitrary function generator and
another instrument, use the external reference output connector.

5. USB: Used to connect a USB controller. (Type B)

6. LAN: Used to connect the instrument to a network. Connect a 10BASE-T
or 100BASE-T cable here.

7. GPIB: Used to control the instrument through GPIB commands.

8. Chassis Ground Screw: The chassis ground screw is used to ground the
instrument. Use a unified coarse screw (#6-32, 6.35 mm length or less).

9. Security Slot: Use a standard laptop computer security cable to secure your
instrument to your location.

AFG3000 Series Quick Start User Manual 39



Instrument interface, front panel, and rear panel

40 AFG3000 Series Quick Start User Manual



Operating basics

Quick tutorial: How to select a waveform and adjust parameters
If you are a beginning user, you can follow the steps described here to get
acquainted with how to select a waveform and adjust waveform parameters.

1. Press the power button to on the instrument.

2. Connect the CH1 Output of the instrument to the oscilloscope input with a
BNC cable.

3. Select a waveform.

4. Enable the signal output.

5. Observe a waveform displayed on the oscilloscope screen.

6. Use the front-panel shortcut buttons on the instrument to select a waveform
parameter.

7. Select Frequency as a parameter to be changed.

8. Change the frequency value using the numeric keys.

9. Change the waveform parameters using the general purpose knob and the
arrow keys.

Quick tutorial: How to generate a sine waveform
If you are a beginning user, you can follow the steps described here to learn how
to generate a continuous sine waveform.

1. Connect the power
cord, and then push the
front-panel power on/off
switch to turn on the
instrument.

2. Connect a BNC
cable from the CH1
Output of arbitrary
function generator to
an oscilloscope input
connector.

3. Push the front-panel Sine
button, and then push
the Continuous button to
select a waveform.
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4. Push the front-panel
CH1 Output On button to
enable the output.

5. Use the oscilloscope
auto-scaling function to
display the sine waveform
on the screen.

If the instrument outputs
a default sine waveform,
you can manually set the
oscilloscope as follows:

0.5 μs/div

200 mV/div

6. To change the frequency,
push the front-panel
Frequency/Period
shortcut button.

7. The
Frequency/Period/Phase
Menu is displayed and
Freq is selected. You
can now change the
frequency value.
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8. To change the frequency
value, use the keypad
and Units bezel buttons.

For example, if you enter
a value "2" using the
keypad, the bezel menus
will automatically change
to Units.

After entering the
frequency value, push
the Units bezel button
or the front-panel Enter
button to complete the
entry.

You can change the
Amplitude, Phase, and
Offset values in the same
way.

9. You can also change the
frequency value using
the general purpose knob
and the arrow keys.

To increase the value,
turn the knob clockwise.

To change a specific digit,
select it by pushing the
arrow keys. Then change
it by turning the knob.

Quick Tips Use the front-panel shortcut buttons to quickly select a waveform parameter.

You can also specify a waveform parameter by using bezel menu selection.
This method does not use the front-panel shortcut buttons.

When you specify a waveform parameter using the shortcut buttons or bezel
menu selection, an active parameter is displayed in green in the graph area.
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Quick tutorial: Instrument help system
The instrument help system allows you to access information about specific menu
items and instrument functions when you need help. You can access and navigate
this help system using front panel buttons and knobs, and following on-screen
instructions as they appear. The individual help topics may contain links to other
topics, as well. These can be accessed by following the on-screen instructions.

How to access the
instrument help system

You can follow the steps described here to access the instrument help system.

1. Push the front-panel Help
button to display the help
screen.

2. Turn the general purpose
knob to move the
highlight from one link to
another.

3. Push the Show Topic
bezel button to display
the topic corresponding
to the highlighted link.

4. Push the Index bezel
button to display an Index
page.

5. Push the Exit bezel
button or any front-panel
button to remove the
Help text from the screen
and return to the graphic
or parameter display.

Ways to access and
navigate the instrument

help system

Push the Help button to display information (topic) about the last menu
displayed on the screen.

Turn the general purpose knob to move from page to page within a displayed
topic.

Push the Index bezel button to view the Help index page.

Push the Page Up or Page Down bezel buttons to search for the index page
that contains the topic you want to view.

Turn the general purpose knob to highlight a help topic in the index.

Push the Show Topic bezel button to display the topic from the index page.

Push the Utility button and then the Language bezel button to choose the
language in which you want the Help topics, bezel menus, and on-screen
messages to appear.
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Generate a Pulse Waveform
1. Push the front-panel

Pulse button to display
the Pulse screen.

2. Push the
Frequency/Period
shortcut button to select
Frequency or Period.

3. Push the Duty/Width
shortcut button to
toggle between Duty
and Width.

4. Push the
Leading/Trailing
shortcut button to
toggle the parameters
for Leading Edge and
Trailing Edge.

5. You can set the lead delay by pushing the Phase | Delay shortcut button to display the
lead delay setting screen and adjusting the parameter as needed. You can also select
Lead Delay from the bezel menu.

Pulse waveform formulas The following formulas are applied to leading edge time, trailing edge time, pulse
period, and pulse width of pulse waveforms.

lEdge (Leading Edge Time)

tEdge (Trailing Edge Time)

AFG3000 Series Quick Start User Manual 45



Operating basics

Maximum leading edge time. This value is the minimum of the three in each
instance.

If runMode = Continuous:

Temp1 = 0.8 * 2.0 * width – tEdge;

Temp2 = ( period – width ) * 0.8 * 2.0 – tEdge;

Temp3 = 0.625 * period.

Else:

Temp1 = 0.8 * 2.0 * width – tEdge;

Temp2 = ( period – leadDelay – width ) * 0.8 * 2.0 – tEdge;

Temp3 = 0.625 * period.

Maximum trailing edge time. This value is the minimum of the three in each
instance.

If runMode = Continuous:

Temp1 = 0.8 * 2.0 * width – lEdge;

Temp2 = ( period – width ) * 0.8 * 2.0 – lEdge;

Temp3 = 0.625 * period.

Else:

Temp1 = 0.8 * 2.0 * width – lEdge;

Temp2 = ( period – leadDelay – width ) * 0.8 * 2.0 – lEdge;

Temp3 = 0.625 * period.
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Save/Recall Arbitrary Waveforms
You can save up to four arbitrary waveforms in the instrument internal memory.
To save more waveforms, use a USB memory.

1. To recall or save an
arbitrary waveform, push
the front-panel Edit button
to display the Edit menu.

2. Select Read from...
to recall an arbitrary
waveform.

3. The Read Waveform
page is displayed.

4. To save waveforms,
select Write to... to
display the Write
Waveform page.

5. If you save a waveform
to a USB memory, a file
with the extension TFW
is saved.

6. You can also recall
waveforms by pushing
the front-panel Arb > Arb
Waveform Menu bezel
buttons.
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Quick Tips Push the -more- bezel button in the Write to... submenu to display the
Lock/Unlock and the Erase menu.

The Lock/Unlock function allows you to lock the file against accidental
overwrite.

Generate an Arbitrary Waveform
The instrument can output an arbitrary waveform that is stored in the internal
memory or a USB memory.

1. Push the front-panel Arb button.

2. Push the Arb Waveform Menu
bezel button.

3. The Arb Waveform Menu is
displayed. You can now browse
a list of waveform files in
the internal memory or USB
memory.

Select Internal. You can specify
a file from the following:

User 1, User 2, User 3, or User 4

Edit Memory 1 or Edit Memory 2

NOTE. Edit Memory 2 is
only available on dual-channel
instruments. Edit Memory 1 relates to
Channel 1 and Edit Memory 2 relates
to Channel 2.

Use the front panel general
purpose knob to scroll the files,
then select a file and push OK.

Quick Tips File names are displayed only in English characters. If you use non-English
characters to name a file, these characters are replaced by Roman symbols
such as #, $, %.

Use the Write to... bezel menu in the Edit menu to copy a waveform file on
the USB memory to the internal memory.
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Modify an Arbitrary Waveform (Edit Menu)
To modify an arbitrary waveform, use the Edit Menu. The Edit Menu supports
several waveform edit functions and provides import or storage of edited
waveform data. Dual-channel model instruments have two edit memories (Edit
Memory 1 and Edit Memory 2). The Edit Menu also supports copying waveform
data between these two memories.

1. Push the front-panel Edit button
to display the Edit Menu.

2. Select Number of Points to set
the number of waveform points
to be edited.

3. Select New to write a standard
waveform to Edit memory.
The written waveform has the
number of points specified by
Number of Points. One of five
waveform types (Sine, Square,
Ramp, Pulse, and Noise) can be
selected.

4. Select Operation to display the
Operations submenu.

5. Select Read from... to specify
a memory location of waveform
data from Internal or USB.
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6. Push Operation to display the
Operations submenu.

Push Line to display the Line
edit submenu.

Push Data to display the Data
Point edit submenu.

Push Cut to display the Cut
Data Points submenu.

7. Select Paste at Beginning to
append a waveform at the
beginning of the edit waveform.

Select Paste at End to append a
waveform at the end of the edit
waveform.

8. Select Copy to EMEM1/EMEM2
to copy waveform data between
Edit Memory 1 and Edit Memory
2. (This menu item is only
available on dual-channel
instruments.)

9. Select Write to... to display a
submenu to write waveform data
to.
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Arbitrary Waveform Edit
Example 1

The following example shows how to use the Line edit function. Paste a ramp
waveform before sine waveform:

1. Select Number of
Points to set the
number of waveform
points to 1000 points.

2. Select New and then
select Sine. Save this
waveform to User1.

3. Next, create a 500
point ramp waveform.

4. Select Operation and
select Line. Do the
following line edit:

X1: 1, Y1: 8191

X2: 250, Y2: 16382

Push Execute. Once
again, select Line from
Operation and perform
the following line edit:

X1: 251, Y1: 16382

X2: 500, Y2: 8191

5. Push Execute. Save
this waveform to
User2.

6. Next, paste a
waveform. Push Read
from... and select
User1.

7. Push Paste at
Beginning. Select
User2 waveform and
then select Paste.

8. The waveform shown
here is created.
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Arbitrary Waveform Edit
Example 2

The following example shows how to edit a waveform by data point. In this
example, you can add a noise spike to the sine waveform.

1. Push Read from... and
select User1.

2. Push the front-panel
View button to change
the screen to Table
display.

3. Push Operation and
select Data.

4. Perform the following
data point edit:

X: 250, Y: 8191

X: 251, Y: 8191

X: 750, Y: 8191

X: 751, Y: 8191

5. After each data edit,
push Execute to
implement the edit
operation. Save this
waveform to User3.

6. This is an example of an
oscilloscope screen for
the User3 waveform.
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Quick Tips If you edit arbitrary waveform data in Edit Memory 1 or 2 while the
instrument generates a waveform from edited Edit Memory, the edited
data will be automatically reflected to the generated waveform from the
corresponding channel.

Push the front-panel View button in the Edit Menu to toggle between edit
texts and graphical views.

Push the front-panel Channel Select button to toggle between the Edit
Memory 1 and Edit Memory 2 menus.

Generate Noise/DC
1. Push the front-panel

More... button.

2. Push the More Waveform
Menu bezel button.

3. Select Noise.

4. You can set waveform
parameters for Noise.
This is a sample of
Gaussian Noise displayed
on an oscilloscope screen.

5. Push DC to display DC
parameters.
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Quick Tip You cannot modulate or sweep noise or a DC waveform.

Generate a Burst Waveform
The instrument can output a burst using standard waveforms such as sine, square,
ramp, and pulse, or arbitrary waveforms. The instrument allows you to use the
following two types of burst modes:

Triggered Burst Mode. A specified number (burst count) of waveform cycles
are output when the instrument receives a trigger input from the internal trigger
source, an external trigger source, a remote command, or the Manual Trigger
button.

Gated Burst Mode. The instrument outputs a continuous waveform when an
effective gate signal is applied externally, when the Manual Trigger button is
depressed, when a remote command is applied, or during 50% of the selected
internal trigger interval.

To Generate a Triggered
Burst Waveform

The following example describes how to generate a double pulse using the burst
mode.

1. Select Pulse as an
output waveform
and then push the
front-panel Burst
button.

2. Confirm that 1-Cycle,
N-Cycles, or Inf-Cycles
is selected, which
means triggered burst
mode is enabled.

To generate double
pulse, set the burst
count (N-Cycles) to 2.

3. This is an example of
double pulse.

4. This waveform is a
trigger output signal.
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To Generate a Gated Burst
Waveform

In the gated burst mode, the output is enabled or disabled based on the internal
gate signal or an external signal applied to the front-panel Trigger Input connector.
While the gate signal is true or the front-panel Manual Trigger button is pushed
in, the instrument outputs a continuous waveform.

1. Push the front-panel Burst
button to display the burst
menu.

2. Select Gate.

3. This is a sample
oscilloscope screen.
The top waveform is a
trigger output signal.

4. This is a gated waveform
sample.

Quick Tips The instrument provides the following three trigger sources for Burst mode:

Internal or external trigger signal

Manual trigger

Remote command

Once Gate is selected, burst count parameters are ignored.

Sweep a Waveform
The Sweep outputs a waveform with the output signal frequency varying linearly
or logarithmically.

You can set the following parameters for Sweep:

Start frequency

Stop frequency

Sweep time
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Return time

Center frequency

Frequency span

Hold time

1. Select a waveform and
then push the front-panel
Sweep button.

2. You can specify the
start frequency, stop
frequency, sweep time
and return time from the
sweep menu.

Return Time represents
the amount of time from
Stop Frequency to Start
Frequency.

Push the -more- button
to display the second
sweep menu.

56 AFG3000 Series Quick Start User Manual



Operating basics

3. In this page, you can set
the parameters for center
frequency, frequency
span, hold time and
select the sweep type.

Hold time represents the
amount of time that the
frequency must remain
stable after reaching the
stop frequency.

Push the -more- button
to display the second
sweep menu.

4. In this page, you can
select the sweep mode
(Repeat or Trigger) and
trigger source.

5. This is a sample
oscilloscope screen.
The top is a sample of a
sweep waveform.

6. This is a trigger output
signal.

Quick Tips For frequency sweep, you can select a sine, square, ramp, or arbitrary
waveform. Pulse, DC, and Noise waveforms cannot be selected.

Once the sweep is selected, the frequency is swept from the sweep start to
the sweep stop frequencies.

If a start frequency is lower than a stop frequency, the instrument sweeps from
the low frequency to the high frequency.
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If a start frequency is higher than a stop frequency, the instrument sweeps
from the high frequency to the low frequency.

If you want to return to the Sweep menu after selecting other menus, push
the front-panel Sweep button again.

Modulate a Waveform

To Output an AM Waveform 1. Select a waveform and then
push the front-panel Modulation
button.

In this example, use sine
waveform as an output waveform
(carrier waveform).

2. Push the top bezel button to
display the modulation selection
menu.

Select AM as the modulation
type.
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3. Select modulation source.

4. Set modulation frequency.

5. Select modulation shape.

6. Set modulation depth.

7. This is an example amplitude
modulation waveform displayed
on an oscilloscope screen.

Quick Tips You can output frequency modulation or phase modulation waveforms in
the same way.

You cannot select Pulse, Noise, or DC as a carrier waveform.

You can select an internal or external signal as an AM source. If you select
an external source and set the modulation depth to 120%, the output will be
at the maximum amplitude when a ±1 Vp-p signal is applied to the rear panel
EXT MODULATION INPUT connector.

You can select a modulation shape from the internal memory or USB memory.

The following equations show the output amplitude of AM, FM, and PM
modulation (in this example, sine waveform is used for carrier waveform
and modulation waveform):

AM: Output(Vp-p)= (1 +
)

FM: Output(Vp-p)=

PM: Output(Vp-p)=
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Carrier amplitude A [Vp-p]

Carrier frequency fc [Hz]

Modulation frequency fm [Hz]

Time t [sec]

AM Modulation depth M [%]

FM Deviation D [Hz]

PM Deviation P [degree]

The following table shows relationship between modulation depth and
maximum amplitude for AM modulation waveform (internal modulation
source is selected):

Depth Maximum amplitude

120% A (Vp-p)

100% A (Vp-p) * 0.909

50% A (Vp-p) * 0.682

0% A (Vp-p) * 0.455
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To Output an FSK
Waveform

Frequency Shift Keying modulation is a modulation technique that shifts the
output signal frequency between two frequencies: the carrier frequency and Hop
frequency.

1. Follow the steps described
in the To Output an AM
Waveform procedure to display
the modulation type selection
submenu. (See page 58,
Modulate a Waveform.)

In this example, select FSK as
the modulation type.

2. The FSK parameter setting
screen is displayed.

Select Internal or External as
FSK source.

3. If you select Internal, you can set
the FSK Rate.

If you select External, the FSK
Rate is ignored.

4. Set Hop Frequency.

Carrier waveform frequency
shifts to the Hop frequency with
the specified FSK rate, and then
returns to the original frequency.
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Quick Tip The AFG3000 series instruments generate a phase continuous FSK signal.

To Output a PWM
Waveform

Follow these steps to output a PWM waveform.

1. Push the front-panel
Pulse button, and
then push the Pulse
Parameter Menu bezel
button to display the
pulse parameter setting
screen.

2. Push the front-panel
Modulation button
to display the PWM
parameter setting screen.

Select the PWM source.

3. Set the PWM frequency.

4. Select the Modulation
Shape.

5. Set the Deviation (pulse
width deviation).
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Quick Tip See an application example of pulse-width modulation. (See page 94,Motor
Speed Control by Pulse-Width Modulation.)

Trigger Out
The Trigger Output signal of the instrument is linked to run mode and function
selected in CH1, if your instrument is a dual-channel model.

1. Connect the front-panel
Trigger Output connector
and the external trigger
input connector of the
oscilloscopes. The
Trigger Output connector
provides the trigger signal
for oscilloscopes.

2. Continuous mode: The
trigger output is a square
waveform and the rising
edge at the start of each
waveform period.

When an output
frequency is higher
than 4.9 MHz, some
restrictions are applied.
See the Quick Tips below.

3. Sweep mode: When the
Repeat or Trigger sweep
mode and internal trigger
source are selected, the
trigger output is a square
waveform and the rising
edge at the start of each
sweep.
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4. Modulation mode: When
internal modulation
source is selected,
the trigger output is a
square waveform of the
same frequency as the
modulating signal.

When an external
modulation source is
selected, the trigger
output is disabled.

5. Burst Mode: When
internal trigger source is
selected, the trigger
output is a square
waveform and the rising
edge at the start of each
burst period.

When an external trigger
source is selected, the
trigger output is high
during the time the trigger
input is high.
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Quick Tips When a setting frequency of an output waveform is higher than 4.9 MHz, a
divided frequency that is lower than 4.9 MHz is output from the Trigger Out.
See the table below:

Set frequency of output waveform (MHz) Trigger output frequency (MHz)

〜4.900 000 000 00 Fs

4.900 000 000 01 to 14.700 000 000 0 Fs/3

14.700 000 000 1 to 24.500 000 000 0 Fs/5

24.500 000 000 1 to 34.300 000 000 0 Fs/7

34.300 000 000 1 to 44.100 000 000 0 Fs/9

44.100 000 000 1 to 50.000 000 000 0 Fs/11

50.000 000 000 1 〜 No signal

NOTE. The Trigger Out signal cannot be output when the instrument outputs a
continuous signal higher than 50 MHz.

NOTE. When the instrument outputs a modulation waveform, Trigger Output
signal cannot be output if you select External as the modulation source.

Adjusting Parameters of Two Channel Signals (dual-channel models only)
Phase The AFG3000 series uses phase continuous method to change frequency. When

you change a frequency of a channel, it will affect the phase relationship between
the two channels.

For example, the instrument is generating a 5 MHz sine waveform for both CH1
and CH2 and the phase is adjusted between the two channels. If you change the
CH2 frequency to 10 MHz and then return it to 5 MHz, the CH2 phase does
not return to its initial condition. To adjust the phase relationship between the
two channels, you need to stop signal generation and restart it. The instrument
provides a function called " Align Phase" to adjust the phase relationship.
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1. In this example, a
5 MHz continuous
sine waveform is used.
Confirm that both phases
are set to 0 degrees.

2. Change the CH1
frequency to 10 MHz,
and then back to 5 MHz.
In this state, the CH2
phase does not return to
its initial condition.

3. To align the phase of two
channel signals, push the
Align Phase bezel button.

4. When you push the
Align Phase button,
the instrument will stop
the signal generation,
adjust the phases of
both channels, and
automatically restart the
signal generation.
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Amplitude To set the CH1 amplitude and CH2 amplitude to the same level, follow these steps:

1. Push the front-panel
Amplitude/High shortcut
button.

2. Push the -more- bezel
button.

3. Page two of
Amplitude/Level Menu is
displayed.

You can set the CH1 and
CH2 amplitude to the
same level by selecting
On in the second bezel
menu from the top.

Frequency (Period) To set the CH1 frequency and CH2 frequency to the same value, follow these
steps:

1. Push the front-panel
Frequency/Period
shortcut button to display
the Frequency/Period
Parameter Menu.

2. You can set the CH1 and
CH2 frequency to the
same value by selecting
On in the third bezel
menu from the top.
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Set up Load Impedance
The output impedance of the AFG3000 series is 50 Ω. If you connect a load other
than 50 Ω, the displayed Amplitude, Offset, and High/Low values are different
from the output voltage. To make the displayed values same as output voltage,
you need to set load impedance. To set the load impedance, use the Output menu.

1. Push the front-panel Top
Menu button, and then
push the Output Menu
bezel button. The Output
Menu is displayed.

2. Push Load Impedance
to display the Load
Impedance submenu.

3. To adjust the load
impedance, select Load.

4. You can set the load
impedance to any value
from 1 Ω to 10 kΩ.

5. When the load
impedance is set to
other than 50 Ω, the set
value is displayed in the
output status.

Quick Tips The load impedance is applied to the amplitude, offset, and high/low level
settings.

When dBm is specified for output amplitude units, the amplitude units setting
is automatically changed to Vpp if you select high impedance.
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Invert Waveform Polarity
To invert a waveform polarity, use the Output menu. The following example
shows how to get a differential signal using the invert function of dual channel
model:

1. Select the CH1
waveform.

2. Push the front-panel
Frequency/Period button.

3. Push the Frequency
bezel button to set the
CH1 frequency.

4. Select the third bezel
button from the top to
set the two channel
frequencies to the same
value.

5. Push the front-panel
Channel Select button to
select CH2.

6. Push the Output Menu
> Invert bezel buttons to
invert the CH2 waveform.

7. Push the front-panel
CH1 Output On button to
enable the output.

8. You can get a differential
signal.
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Add Noise
To add the internal noise signal to a waveform, use the Output menu.

1. Push the front-panel
Sine > Continuous button
to display the Sine
waveform screen in this
example.

2. Follow the steps
described in the previous
pages to display the
Output Menu. (See
page 68.) To add noise
to a sine waveform, push
Noise.

3. The Noise Add submenu
is displayed. Push Noise
Add to select On.

4. To adjust the noise level,
push Noise Level. Use
the general purpose
knob or the numeric pad
to enter the value.

5. This is a waveform before
adding noise.

6. This is a waveform after
adding noise.

To avoid overflow by
noise addition, the
amplitude of the output
signal is automatically
halved.
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Quick Tips An internal noise generator (digital) is used to add noise.

CH1 and CH2 noise signals are non-correlating.

The Output Status is changed from Output Off to Noise when you push the
front-panel Channel Output button to enable the output.

NOTE. When you set Noise Add to On, the amplitude of output signal is reduced
to 50%.

Add Signal (AFG3100 and AFG3200 Series)
The AFG3101 / 3101C / 3102 / 3102C and AFG3251 / 3251C / 3252 / 3252C rear
panel ADD INPUT connector allows you to add an external signal to the CH1
output signal.

1. Connect an external
signal source to the
rear panel ADD INPUT
connector.

2. Push the front-panel Top
Menu button, and then
push the Output Menu
bezel button.

3. Push External Add to
select On.
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4. The following is an
example of adding noise
as an external signal.
The upper waveform is
an external signal.

5. The bottom waveform is a
square waveform before
adding external signal.

6. This is an example of
square waveform after
adding external signal
(noise).

Quick Tip The Output Status is changed from Output Off to Ext Add when you push the
front-panel CH1 Output button to enable the output.

Generating a Differential Signal
A dual-channel instrument can be used to generate a differential signal by
programming CH2 to output the complement of CH1. The CH2 settings can be
configured conveniently by using the CH1 Complement function.
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1. After setting the CH1
waveform parameters,
push the front-panel
Channel select button to
select CH2.

2. Push the front-panel Top
Menu button, and then
push the Output Menu
bezel button.

3. Push the CH1
Complement bezel
button.

4. The CH2 wave shape
and timing parameters
are copied from CH1,
and the CH2 amplitude
settings are inverted from
CH1.

NOTE. When CH1 is selected in the AFG310x or AFG325x series instrument, the
instrument displays External Add Off/On in the Output menu.
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External Reference Clock
1. The external reference

input (EXT REF INPUT)
and the external
reference output
(EXT REF OUTPUT)
connectors are provided
on the AFG3000 series
rear panel.

2. The instrument can use
the internal or external
signal as a reference
signal.

To select a reference
signal, push the
front-panel Utility button
and then push the
System bezel button.

3. Push the Clock Ref bezel
menu button to toggle
between Internal and
External.

Quick Tips The external reference Input and Output connectors are used for synchronizing
multiple AFG3000 series instruments.

The instrument can use the internal source or an external source as a reference
signal. When the internal reference is activated, a 10 MHz reference signal
is output on the rear panel EXT REF OUT connector. This output signal
synchronizes other devices to the instrument.

When the external reference input is activated, the rear panel EXT REF
INPUT connector is used as the input for an external reference signal. The
instrument is synchronized by this external reference signal.

The EXT REF OUTPUT connector is not provided on the AFG3021,
AFG3022 AFG3051, or AFG3052.
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Synchronous Operation
To synchronize multiple arbitrary function generators, use the Utility menu.
Some documentation may also refer to the synchronous operation as master-slave
operation.

1. Use a BNC cable to
connect the front-panel
Trigger Output of one
instrument (master) to the
Trigger Input of another
unit (slave).

The master unit sends a
trigger signal to the slave
unit.

2. Connect the rear panel
EXT REF OUT (master)
and EXT REF IN (slave)
with another BNC cable.

The master clock and
the slave clock are
synchronized.

3. Push the front-panel
Utility button of the
master unit to display the
System menu.

4. Sets the following:

Trigger Out - Sync

Clock Ref - Internal

5. Set the slave instrument:

Display the System
menu, and then push the
Clock Ref bezel button to
select External.
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6. Select Burst as the Run
Mode for both the master
and the slave instrument.

To synchronize two
instruments, you must
stop running output
signals once before
triggering using the Burst
mode.

7. Select the trigger source
of the slave unit.

Push the -more- bezel
button in the Burst mode
to display the second
page.

8. Push the Source bezel
button to select External.

Confirm that Internal is
selected in the master
and External is selected
in the slave for Source.

9. This screen shows signal
outputs by master-slave
operation. The top
waveform is the signal of
the master unit.

10. When one meter long
cables are used, the
slave signal(s) delays
approximately 40 ns.

11. To make the delay
between the master and
slave 0 (zero), set Delay
of the master unit.

12. The screen shows
waveforms after setting
the delay to the master
unit. The top waveform
is master and the two
bottom waveforms are
slaves.
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Quick Tip To output continuous waveforms by synchronous operation, select External
as the trigger source for the master unit to stop signal generation. Select
Inf-Cycles as the burst count for both master and slave units. Change the
trigger source of the master unit to Internal to restart the signal generation.

USB Memory
A USB memory connector is provided with all the Tektronix AFG3000 Series
Arbitrary Function Generators to allow you to perform the following tasks:

Save or recall user-defined waveforms to/from a USB memory

Save or recall setups to/from files on a USB memory

Update your instrument firmware

Save a screen image

CAUTION. When you attach a USB memory to the instrument, a caution message
appears on the screen. Do not remove the USB memory until the message
disappears.

If you remove the USB memory while this caution message is displayed, it may
cause damage to the instrument.

Read more about saving/recalling user-defined waveforms. (See page 47,
Save/Recall Arbitrary Waveforms.). Read more about saving/recalling instrument
setups. (See page 80, Save/Recall Instrument Setup.). Read more about updating
your instrument. (See page 15, Update your instrument firmware.)

Quick Tips Use a USB memory with cross section smaller than 20 mm x 12 mm to
connect to the AFG3000 series front panel USB connector. To connect a
larger USB memory, use an extension cord.

The AFG3000 series instruments support a USB memory with a FAT12,
FAT16, or FAT32 file system.

NOTE. Emissions may exceed the specification limit if a USB cable is placed in the
front-panel USB memory connector. Use only appropriate USB memory devices.
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Utility Menu
Push the front-panel Utility button to display the Utility menu. The Utility menu
provides access to utilities used by the instrument such as I/O interface, system
related menus, diagnostics/calibration, and local language preferences.

1. Push the front-panel
Utility button to display
the Utility menu.

2. I/O interface. (See
page 17.).

3. Language selection. (See
page 10.).

4. For System related
menus, see step (See
page 78.) 6 and step 10.

5. Push the Status bezel
button to display the
instrument status.

Push the System bezel
button to display the System
submenu.

6. Trigger Out. (See
page 63.).

7. Reference Clock. (See
page 74.).

8. You can select the
instrument power-on
settings.

9. Executing the Secure
function will erase all data
except Mac Address,
calibration data, and the
instrument serial number.

10. Push the -more- button to
display the second page.
Push Contrast to adjust
the screen contrast.

11. Push Screen Saver to
toggle the screen saver
Off and On.

12. Push Click Tone to toggle
the click tone Off and On.

13. Push Beeper to toggle the
beep sound Off and On.
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14. Push the previous menu
arrow button located
beneath the bezel buttons
to return to the previous
menu. Push the -more-
button to display the
second page.

15. For Backup/Restore, see
step 17.

16. You can copy the
waveform parameter
of one channel to another
channel.

17. Push the Backup/Restore
bezel button to display
the Backup/Restore
submenu.

In this menu, you can
back up a waveform data
from internal memory to
USB memory, or restore
a waveform data from
USB memory to internal
memory.

18. Return to the Utility main
menu. Push the -more-
bezel button to display
the third page. On this
page, you can execute
the instrument firmware
update. (See page 15,
Update your instrument
firmware.)

19. Security Menu. (See
page 81, Using the
Security Menu.).
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Save/Recall Instrument Setup
You can save setups of the instrument as files in the internal memory or in an
external USB memory. You can recall the stored setups from a file in the internal
memory or in a USB memory.

1. Push the front-panel
Save button to display
the Save Menu.

2. To specify a memory
location, select Internal
or USB. In this example,
select USB.

Use the general purpose
knob to scroll files. Push
Save to save a setting.

3. You can save a setup as
a new file if you specify
USB. Push Save As.

4. You can enter a file name
in this screen. Use the
general purpose knob to
select a character. Push
the Enter Character bezel
button or the front-panel
Enter key to enter the
character.

5. To recall a setup, push
the front-panel Recall
button.

6. Select a memory location
(Internal or USB), and
then push the Recall
bezel button.

Quick Tips You can lock a setup file to avoid accidental overwrite. When a memory
location is locked, a lock key icon will appear on the screen. To lock or unlock
a setup file, push the Lock/Unlock bezel button.

To erase a file, push the Erase bezel button.

Output state is Off by default after reading a setup file.

If you save a setup to a USB memory, a file with the extension TFS is saved.
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Saving a Screen Image
You can save a screen image of the instrument to a USB memory. Do the
following steps:

1. Insert a USB memory
to the front-panel USB
connector.

2. Set the display to show
the screen you want to
save as image. Then
simultaneously push
the two arrow keys
underneath the rotary
knob on the front panel.

3. A message appears on
the screen, indicating that
the screen image was
saved.

4. Push OK.

Quick Tips Image files are saved in a folder named "TEK" in the USB memory.

Image files are saved as .BMP format. The instrument gives all files created
by the instrument the default name TEK00nnn.BMP, where the nnn are
placeholders for an automatic number sequence from 000 to 999.

Using the Security Menu
Use the Security menu to limit access to the following menus:

Firmware update

Service menu (Refer to the service manual for information about the service
menu.)
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Access Protection The access protection is set to Off by default. To turn the access protection on,
do the following steps:

1. Push the front-panel
Utility button to display
the Utility menu, and then
push the -more- bezel
button twice.

2. Select Security Menu.

3. Select Access Protection
to display the password
input page.

4. Enter your password.
Use the general purpose
knob to select the
characters and push
the Enter Character
bezel button after each
selection.

As you enter the
characters of your
password, they are
displayed as a series of
asterisks (*******) on the
password input page.

If no specific password
has been previously
defined, use the default
password DEFAULT.

5. Select OK to turn the
access protection on.

NOTE. When Access Protection is on, the Change Password bezel button is
disabled.

Changing the Password Before the password is changed for the first time, the default password is
DEFAULT. To change the password, do the following steps:
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1. Select Security Menu
from the Utility menu.

2. If the Access Protection is
set to On, turn it off using
the Access Protection
menu. Otherwise, skip to
step 3.

3. Select Change Password
to display the password
input page.

4. Enter your current
password.

Use the general purpose
knob to select the
characters and push
the Enter Character
bezel button after each
selection. Then select
OK to display the New
Password input page.

5. Enter a new password.

As you enter the
characters of your new
password, they are
displayed on the screen.
Check carefully to ensure
you are entering the
desired characters.

6. Select OK to activate the
new password.

NOTE. A password must
have at least four characters,
and not more than12
characters.

Quick Tip Use the front-panel general purpose knob to select a character when you enter
a password, and then push the Enter Character bezel button. You can also use
the front-panel numeric keypad and the Enter button.

NOTE. To activate or deactivate the access protection, you must enter the
password you set. If you forget the password, you must return the instrument to
Tektronix to reset the password.
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ArbExpress
ArbExpress is a Windows-based software for creating and editing waveforms for
Tektronix AWG and AFG instruments. With ArbExpress, you can quickly and
conveniently create the desired waveforms and send them to the instrument.

The following table and list describe the system requirements and general features.

System requirements

OS Supported Windows XP Professional or Windows
2000 or Windows 98/Me or Windows NT or
Windows 7 (32-bit only)

Minimum PC Requirements Pentium III 800 MHz and higher 256 MB
RAM 300 MB free hard disk Microsoft
Internet Explorer 5.01 and higher .NET
Framework 1.1 Redistributable 800 x 600
Display resolution

TekVISA Version 3.3.4.6 and above

Create waveforms from standard waveform templates

Modify and transfer waveforms to perform DUT level tests

Directly import waveforms from Tektronix oscilloscopes

Send waveforms to AWG/AFG instruments directly from ArbExpress or
MATLAB

Math operations on waveforms

NOTE. You can use ArbExpress to transfer waveform data to the instrument.
When you transfer waveform data (. tfw file), any part of the waveform outside
of allowed limits in the AFG3000 series will be automatically converted to be
within the allowed range.

The following pages contain the screen interface and basic operating procedures
for using ArbExpress. For more information on ArbExpress, refer to the
ArbExpress online help.
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Screen interface

Item Description

1 Menu bar: The menu bar provides access to the application functions. When
you select a menu item, the application displays the associated dialog box or the
menu selection causes an immediate action.

2 Toolbar: The toolbar buttons provide instant access to most features without
having to navigate through several menus.

3 Shortcut View: The Shortcut view occupies the left part of the display. Use the
Shortcut view to quickly access various functions provided by the application.
Refer to the ArbExpress online help for more information.

4 Status bar: The status bar, located below the waveform and marker display,
shows information about the application and the waveform.

5 Waveform display area: When you create or open a waveform, it will be
displayed in this area.

6 Marker area: Marker patterns appear in this area. You can toggle the display of
markers by selecting Display > Marker from the menu bar.
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Basic operations The following steps explain basic waveform creation and other useful functions
that are available with ArbExpress.

1. To create a new waveform, use the File menu.

2. Blank sheet opens a blank sheet in the window
with 1024 points waveform length. You can
change the number of points using Properties...
from the Waveform menu.

3. Use the Standard Waveform dialog box to
create any of the standard waveforms that are
available. Use Settings to select a desired
waveform and instrument type.

4. Use Vertical to set the waveform vertical
parameters.

5. Use Horizontal to set the waveform horizontal
parameters.

6. Click Preview to view the waveform.

7. You can also use the Equation Editor to create
a waveform. The application provides a set of
sample equations that you can directly use or
modify.

8. Use Command List to select the commands,
functions, units, and operations.

9. Use Preview to view the waveform after the
equation is compiled.
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10. You can also use a waveform math tool.

From the Math menu, select Waveform Math...
to display the Waveform Math dialog box.

11. Select a math source from Waveform Library.
Select Noise in this example.

12. Calculation results are displayed in the
Resultant Waveform pane. This is an example
of adding noise to a square waveform.

13. You can remotely control Tektronix AWG/AFG
instruments using ArbExpress.

From the Communication menu, select
AWG/AFG File Transfer & Control... to display
the dialog box.

14. Connected instruments are listed on the Arb
List.

15. The Instrument Control pane appears only
when an instrument is connected, otherwise it
is hidden.
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Using CSV format
waveform data

ArbExpress allows you to convert a CSV (Comma Separated Value) format file,
which is created by Microsoft Excel, to waveform data that is compatible with
the instrument.

1. Create a CSV file to use with ArbExpress.

2. Enter point or time to this column.

3. Enter data to this column.

When you open a CSV file, a dialog box may
appear to confirm the CSV file format.

4. This is an example of ArbExpress waveform
display area after recalling CSV data.
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5. Save the waveform as the .tfw format.

Copy the waveform data to a USB memory
and load the waveform in the arbitrary function
generator.

6. The AFG3000 series instruments output
recalled waveform data. This is an example of
the oscilloscope screen.

1 Fs represents setting frequency of output waveform.
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This section contains a series of application examples. These simplified examples
highlight the features of the instrument and give you ideas for using it to solve
your own test problems.

Lissajous Patterns
Use your AFG3000 series dual-channel model to create a Lissajous pattern and
observe the waveforms with an oscilloscope.
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1. Connect the CH1 and
CH2 Outputs of the
dual-channel instrument
and the CH1 and CH2
Inputs of an oscilloscope
with BNC cables. Set the
waveform parameters as
follows:

Sine (Continuos)

Amplitude: 1 V

CH1 Frequency:
400 kHz

CH2 Frequency:
500 kHz

2. Set the oscilloscope
display format to XY.
Adjust the amplitude
so that the waveform is
shown in the graticule.

A Lissajous pattern is
displayed.

3. Use the general purpose
knob on the instrument
to change the phase of
CH1 or CH2. Observe
that the Lissajous pattern
changes shape.

92 AFG3000 Series Quick Start User Manual



Application Examples

Measurement of Filter Characteristics
Use the instrument sweep function to observe the frequency characteristics of
the 50 Ω filter.

1. Connect the CH1 output
of the instrument and an
oscilloscope CH1 input
with a BNC cable.

2. Connect the Trigger
Output of the instrument
and the external trigger
input connector of an
oscilloscope.

Set the oscilloscope input
impedance to 50 Ω..

3. Select Sweep from
Run Mode of the
instrument and set
the start frequency, stop
frequency, and sweep
time so that the waveform
is shown in the graticule.

You can measure the
frequency characteristics
of the filter by sweep time
and the oscilloscope time
base.
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Motor Speed Control by Pulse-Width Modulation
Pulse-width modulation is used for controlling the speed of a DC motor or the
luminance of an LED (Light Emitting Diode). Use the instrument PWM function
to control the DC motor speed.

1. Connect the instrument
output and a DUT using
a BNC-to-alligator clip
adapter.

2. Select Pulse as an output
waveform and then select
PWM as a modulation
type.

Set the frequency to
approximately 100 kHz.

3. Connect the output to an
oscilloscope. Confirm
that a pulse-width
modulation waveform
is displayed on the
oscilloscope screen.

Select Pulse Duty and
change the duty rate.
Observe that the motor
speed changes if you
change the duty rate.
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Carrier Null (Frequency Modulation)
Use the instrument and spectrum analyzer to observe a carrier waveform of
frequency modulation.

1. Select Sine as an output
waveform and then select
FM as the modulation
type.

2. Set the waveform
parameters as follows:

Carrier frequency:
1 MHz

Modulation frequency:
2 kHz

3. Change Deviation.

Set the deviation to
4.8096 kHz. It makes
the carrier waveform null.
Confirm that the carrier
null can be observed on
the spectrum analyzer.
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A
Access Protection, 82
Access Protection 67

Firmware update, 16
Accessing Help, 44
ADD INPUT connector

Add signal, 71
Add input signal connector

Rear panel, 39
Add Noise, 70
Add signal

invert waveform, 69
Add Signal, 71
Adjusting parameters of two
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Amplitude, 67

Align Phase, 65
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modulate an output
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Amplitude
Frequency, 67

Amplitude, To change the
units, 36

Application examples
Frequency modulation, 95

Arb button (front panel)
Recalling arbitrary

waveforms, 47
ArbExpress, viii, 84, 89

Basic operations, 86
Saving arbitrary

waveform, 47
screen interface, 85

Arbitrary waveform data
Instrument setups, 80

Arbitrary waveforms
Save and recall, 47

B
Beeper

Utility menu, 78

Bezel buttons
front panel, 24

Bezel menu
screen interface, 25

C
Carrier null

Application examples, 95
Center frequency, Sweep

waveform, 56
CH 1 and CH 2 output connectors

front panel, 24
Change the password

Security menu, 82
Channel selection, 37
Chassis ground screw

Rear panel, 39
Click tone

Utility menu, 78
Connect to a network, 17
CSV file, ArbExpress, 88

D
DC, Standard waveform, 32
Default button, 7
Default setup, 29
Default, Power on settings, 7
Differential signal, 69, 72
Double pulse, 54

E
Edit menu, 49

Recalling waveform data, 49
Environmental requirements, 3
Equation Editor, ArbExpress, 86
Equivalent output circuits, 21
Erase

Arbitrary waveform data, 48
Erase setups and waveforms, 8
Ethernet, 17
Exponential Decay, Standard

waveform, 33

Exponential Rise, Standard
waveform, 33

EXT MODULATION INPUT
connector
Rear panel, 39

EXT REF INPUT connector
Rear panel, 39

EXT REF OUTPUT connector
Rear panel, 39

External reference clock, Rear
panel, 74

F
Firmware updates, 15, 81
Floating ground, 13
Frequency

Period, 67
Frequency modulation

Lissajous patterns, 91
Frequency span, Sweep

waveform, 56
Front panel, 24
Front panel controls

how to lock or unlock, 25
FSK

modify an output
waveform, 61

Function buttons
front panel, 24

Fuse adapter, Protect output
circuits, 12

G
Gated waveform

how to generate, 55
Gaussian, Standard waveform, 32
General features, 1
Generate a burst waveform, 54
Generate a differential signal, 72
Generate a pulse waveform, 45
Generate an arbitrary

waveform, 48
Generate DC, 53
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H
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Hold time, Sweep waveform, 56
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L
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Rear panel, 39
Language selection, 10
Last, Power on settings, 7
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front panel, 24
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Lissajous patterns

Pulse-width modulation, 94
Lissajous Patterns

Application examples, 91
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Lock front panel controls, 25
Lock/unlock

Arbitrary waveform data, 48
Lorentz, Standard waveform, 33

M
Main display area

screen interface, 25
Master-slave operation, 75

Measurement of filter
characteristics
Application examples, 93

Menu buttons
front panel, 24

Message display area
screen interface, 25

Modify an arbitrary waveform, 49
Modulate a waveform, 58

N
Noise, Standard waveform, 32
Number of Points, Edit menu, 49
Numeric keypad

front panel, 24

O
Operating requirements, 3
Option buttons, 25
Output an AM waveform, 58
Output menu

To add Noise, 70
Output On/Off, 38
Output status

Noise, 71
screen interface, 25

Output window, 23
Overheat protection, 23

P
Parameters

how to adjust, 35
Period

Phase, 65
Phase | Delay shortcut button, 28
Power button, 6
Power consumption, 3
Power off, 6
Power on, 6
Power supply requirements, 3
Power switch

front panel, 25
Previous menu button

front panel, 24
Programmer Manual, vii, 21, 29

Protect output circuits, Fuse
adapter, 12

Protect your DUT, 14
Pulse waveform

how to generate, 45
Pulse waveform formulas, 45
Pulse-width modulation

Application examples, 94
Sweep, 93

PWM
modify an output

waveform, 62

R
Rear panel, 39
Recalling waveform data

Saving waveform data, 50
Recommended accessories, 5
Reference signal, Internal or

External, 74
Remote control, ArbExpress, 87
Restore default, 29
Return time, Sweep waveform, 56
Run Mode, 34

S
Save a screen image, 81
Save/Recall arbitrary

waveform, 47, 80
Save/Recall instrument setup, 80
Screen interface, 25

System requirements, 84
Screen saver

Utility menu, 78
Screen view formats, 26
Secure button, 8
Secure function

Utility menu, 78
Security menu, 81
Security menu 67

Firmware update, 17
Security slot

Rear panel, 39
Select a local language, 10
Select a waveform, 41
Select run mode, 34
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Self calibration, 8
Self test

Utility menu, 8
Set up load impedance, 68
Shortcut buttons

front panel, 24
functionality, 28

Side-menu buttons, 25
Sin(x)/x, Standard waveform, 32
Soft keys, 25
Standard accessories, 4
Standard Waveform dialog box,

ArbExpress, 86
Standard waveforms, 30
Start frequency, Sweep

waveform, 55
Stop frequency, Sweep

waveform, 55
Sweep a waveform, 55
Sweep time, Sweep waveform, 55
Sweep waveform

Application examples, 93
Synchronous operation, 75
Synchronous operation 60

Updating instrument
firmware, 15

T
TFS file

Saving instrument setup, 80
To add Noise

To add signal, 71
To invert waveform 55

To protect your DUT, 14
To output a PWM waveform, 62
To output an FSK waveform, 61
To protect your DUT

To set up load impedance, 68
To select a local language, 10
Top menu button

front panel, 24
Trigger input connector

front panel, 24
Trigger out, 63
Trigger output connector, 63

front panel, 24

U
Unlock front panel controls, 25
USB connector

front panel, 25
Rear panel, 39

USB interface, 17
USB memory, 77
USB memory 62

Firmware updates, 15
Utility menu, 78

Access protection, 82

V
View button, 53

front panel, 24
functionality, 26

View tab
screen interface, 25

Voltage units, Conversion table of
Vp-p, Vrms, and dBm, 37

W
Waveform Math dialog box,

ArbExpress, 87
Waveform parameters

how to adjust, 35
Waveforms

how to select, 30
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